
  

Download Tableau Reader 
•  Confirm that your computer is Windows XP, Vista, 7, or 8. 
•  Go to www.tableausoftware.com/pt-br/products/reader. 
•  Click 

 
•  When finished downloading, click the file. 
•  On the “Do you want to run this file” alert box, click Run. 
•  Accept the terms and conditions in the next window by 

checking the box and clicking Install. 
•  If asked if you want to allow the program to install 

software on your computer, click Yes. 
•  After installation, Tableau will open automatically. 

Setting the Language for Adobe Reader 

Set the language in Tableau 
•  After installation, Tableau Reader will open 

automatically. 
•  On the top toolbar go to Help > Choose language. 
•  Select Portugês.  
•  The language is now set. 

If your computer is already set to Portuguese and 
you used the link provided, your Adobe Reader 
should be in Portuguese. If it is not, go to  
http://get.adobe.com/br/reader/otherversions/ 
to choose the right version and language. 

Download Report Software Quick-Reference Guide 

Download Adobe Reader 
•  Confirm that your computer is Windows XP, Vista, 

7, or 8.  
•  Go to http://get.adobe.com/br/reader/ 
•  Click  

•  When finished downloading, click the file. 
•  On the “Do you want to run this file” alert box, click 

Run. 
•  If asked if you want to allow the program to install 

software on your computer, click Yes. 
•  In the Adobe Reader Updater Preferences window 

click Next. 
•  After installation is complete, click Finish. 
•  If you are asked, click Yes to reboot (restart) your 

computer. 
•  Find Adobe Reader in the Start menu and open it. 
•  In the terms and conditions window, click Accept. 
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Understanding the Report 
This report shows the monthly data that has been collected for all facilities in your province. There are 
different graphs and tables that display the data.  

Open the PDF Report 
•  Go into your email and find the message with 

the monthly report. 
•  Double click on the PDF attachment to open it 

in Adobe Reader. You can also right-click on 
the file, choose “Open with” and then select 
Adobe Reader. 

•  The report will open in Adobe Reader. 

Having trouble opening the report? 

If your Adobe Reader software is not up to date you 
may have issues opening PDFs. Visit 
http://get.adobe.com/br/reader/ to download the 
latest version. 
 

Monthly Report PDF Quick-Reference Guide 

Important to Remember: 
★ Data must for the prior month's distribution must be entered by the 15th of the month to be included in reports. 
★ Reports will be emailed to field coordinators and provincial supervisors around the 20th of the month. 

Print the PDF Report 
In addition to the electronic version, you may want a paper version of the report for your records. 
•  With the report open in Adobe Reader, click on File in the top toolbar. 
•  Select Print. 
•  Choose your printing settings and then click Print. 

Page 1 – Monthly Summary Report (most recent month reported) 
This page shows an overview for all the data collected for the most recently reported month. It gives information on 
both vaccine supply chain (e.g. number of stockouts) and health service delivery (e.g. number of children 
vaccinated).  
 
In the Delivery Interval section it also gives information on how often the HU’s were visited. These numbers show 
the average number of days that passed in between FC visits to the HU’s. The ideal is 0-33 days. 

Page 3 – Vaccines Distribution Report (last 6 months reported) 
The HU’s Visited and Data Reported graph shows the percentage of health units that reported and the percentage 
of those that were also visited. If only one line appears it means that the percentages are the same. 
 
The Delivery Intervals graph is a stacked bar chart that shows the delivery intervals for the province for the past 8 
months. The ideal is having a large portion of 0-33 Days in each bar and a very small portion of the other amounts.  
 
The Last Data Update Time indicates the last time that data was pulled from SELV and incorporated into the report. 

  

Page 2 – Cold Chain Status Report (last 6 months reported) 
This page gives information on the refrigerators at the HU’s. The section Non-Working Refrigerators is important 
because it specifies nonworking refrigerators at each HU.  
 
The graph at the left shows the percentage of working refrigerators at the HU’s. The ideal 95% working. The blue 
line shows actual data and the dashed black line is the trend line. 
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  Tableau Monthly Report Quick-Reference Guide 

Report Tab Overview 
Each Tableau workbook report will have multiple tabs that portray different types of information.  
The three main tabs that you will be using are Tabs 1, 2, and 3. These show the same type of information that is on 
pages 1, 2, and 3 of the PDF report. Unlike the PDF report though, this data is both interactive and more detailed. The 
“D” on tabs 6-11 stands for Detailed, which means these tabs provide the most in-depth information in those 
categories. See below for more on each of the tabs. 

# Tab Name Data Portrayed 

1 Relatório de Síntese Mensal Monthly summary for all data entered for the most recent month reported.  

2 Relatório de Estado de Cadeia de Frio Refrigerator data by time period and geography, including list of nonworking 
refrigerators. 

3 Relatório de Distribuição de Vacinas  Vaccine data by time period and geography, including #HU’s visited & 
reporting, delivery intervals, stock-outs, and reasons for no visit. 

4 D Dados Visitadas  Detailed view of HU visited and reporting data, filtered by time period and 
geography. 

5 D Intervalos de Entregas (Dias) Detailed view of delivery interval data, filtered by time period & geography. 

6 D Ruptura de Stock Detailed view of stock-outs data, filtered by time period and geography. 

7 D Material Entregue (raw numbers) Detailed view of supply delivery data, filtered by time period and geography. 

8 D Material Entregue (percentage) Detailed view of supply delivery data, filtered by time period and geography. 

9 D Relatório PAV: Crianças Detailed view of child immunization coverage data by vaccine, filtered by time 
period and geography. 

10 D Taxa de Desperdício, frascos abertos 
 

Detailed view of wastage data for open vaccine vials, filtered by time period 
and geography. 

11 D Taxa de Desperdício, frascos fechados Detailed view of wastage data for closed vaccine vials, filtered by time period 
and geography. 

12 Mapa de desempenho distrital Map showing each district’s performance in aggregation of visits, delivery 
intervals, and stock-outs, filtered by time period and geography.  

13 Mapa de desempenho de US Map showing each facility’s performance in aggregation of visits, delivery 
intervals, and stock-outs, filtered by time period and geography.  

Navigation Tip 
Use the left and right arrow buttons in the bottom righthand corner of the  
Tableau worksheet window to scroll sideways to see more tabs.  

Open the Tableau Report 
•  Go into your email and find the message from your 

provincial supervisor with the monthly report. 
•  Double click on the Tableau attachment to open it. (This 

file will end in .twbx) You can also right-click on the file, 
choose “Open with” and then select Tableau Reader. 

•  The report will open in Tableau Reader. 

Important to Remember: 
★ Data must for the prior month's distribution must be entered by the 15th of the month to be included in reports. 
★ Reports will be emailed to field coordinators and provincial supervisors around the 20th of the month. 

Can’t Open Tableau Report? 
Make sure you have the most recent version of 
Tableau Reader downloaded. Periodically Tableau 
releases new version updates. you have to have 
the latest version to read f i les. Go to 
www.tableausoftware.com/pt-br/products/reader 
for the latest version. 
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B. Set time-window 
To see data from a specific time period you can use the 
sliding bar time selector. It appears in the top righthand 
corner of most of the tab windows. When you adjust the 
time period with the sliders the data will automatically 
update to reflect your selection. Examples from tabs: 
 
 
 
 
or 
 
 
 
 
 

Using Tableau to View Report 
Tableau is designed to provide the user with options of what data to view. To see the information you 
need, use these Tableau tools: 

Important Tip: Time Selector Slide Tool 
The first month of the time period you select on the 
slide will not be included in the data. To get around 
this, always select one month previous to the 
actual period that you want. For example, to see 
data from July 2013 to Dec 2013 select June 2013 
– Dec 2013 on the slide tool. 

C. Filtering data 
This report provides many different filtering options 
through the use of drop-down menus and 
checkboxes. These include filters for Month, 
Province, Delivery Zone, District, and Facility.  
 
Example 1: Say you are a FC for Maputo and want 
to see the monthly summary report data for 
December 2013 for Centro Maputo, all districts and 
facilities. On the Monthly Summary Report tab use 
the drop-down menus to choose: 
 
Period: December 2013 
Delivery Zone: Centro Maputo  
District: (All)  
Facility: (All) 
 
 
Example 2: Say you are a FC for Maputo and want 
to see the stockouts data just for the Mahubo HU 
from Sep 2013 – Dec 2013. On the D Stock Outs 
by Product tab use the slide tool to select: 
  
Month: Aug 2013 - Dec 2013 (Note: see Time 
Selector Tip at left) 
Delivery Zone: uncheck (All), check Sul Maputo  
District: uncheck (All), check Boane 
Facility: uncheck (All), check Mahubo 

A. Report tabs 
The report is organized into tabs that appear at the 
bottom of the window. Click on a tab to see the 
information in that category. 

Filtering Tip: 
If you have filtered any data from (All) to a more 
specific selection, you need to reselect (All) for all 
lower-level filters before changing a higher filter. 
For example, change the facilities filter to (All) 
before readjusting the district filter, change district 
to (All) before readjusting the delivery zone filter, 
etc. 
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Using Tableau to View Report (cont) 
Tableau is designed to provide the user with options of what data to view. To see the information you need, 
use these Tableau tools: 

Tableau Monthly Report Quick-Reference Guide 

F. Export data to Excel 
You can export Tableau report data to Excel for 
each tab. To export: 
•  Open the tab you want to export. Note: This 

only works for the “D” (Detailed) tabs (6-11). 
•  Go to Planilha (Worksheet) > Exportar > 

Tabela de referência cruzada para Excel 
(Crosstab to Excel). 

•  Excel will open automatically and create a new 
workbook with the data from the Tableau tab.  

 

E. Print 
To print the entire Tableau report: 
•  Go to File > Print. 
•  Make sure “Pasta de trabalho inteira” “Entire 

Workbook” is selected for Print Range. 
•  Click OK. 
 
To print a specific report tab: 
•  Open the tab you want. 
•  Go to Arquivo (File) > Imprimir (Print) 
•  Select “Planhila ativa” “Active Sheet” for Print 

Range. 
•  Click OK. 
 

D. Drill-down into data 
Another feature is the data drill-down, which allows allows you 
to toggle through the hierarchical organization of geographical 
regions to see either specific or general data. With it you can 
expand viewable data for Province, Delivery Zone, and District. 
 
Drill-down is available on all tabs that begin with the initial 
“D” (e.g. D Data Visited). To drill down: 
•  Hover your cursor above the geographical category you 

wish to expand or contract.  
•  Either a small plus sign button (expand) or minus button 

(collapse) will appear. This depends on whether the 
category is already expanded or not. 

•  Click the button to toggle through the drill down. 
 
Example: Say you are a FC for Maputo and want to compare the 
wastage rates between the HU’s in Centro Maputo, Matola district for 
July and August of 2013. On the D Wastage tab set the slide bar to 
June 2013 – Aug 2013. Then hover your cursor above the Province 
column and click the plus button that appears. 
 
 
 
 
Now you will see the rates for each of the individual zones. Hover 
above Delivery Zone and click the plus button to expand to see the 
districts. 
 
 
 
 
 
 
Hover above District and click the plus button to expand to see 
facilities. To collapse the view just hover again and click the minus 
button.  
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Understanding Report Tabs 
There are three main tabs that are important to understand. These portray the same information that is on 
the PDF report but they allow for a more interactive understanding of the data. 

Tab 1: Monthly Summary Report 
This tab shows an overview for all the data collected for each month. It gives information on both vaccine supply 
chain (e.g. number of stockouts) and health service delivery (e.g. number of children vaccinated). Use the Period 
drop-down menu to select the month you wish to view. Use the other drop-down menus to filter geographically as 
needed. 
 
Pay special attention to: 
 
Delivery Intervals 
This section gives information on how many days passed between HU visits. The ideal is 0-33 days, meaning 
that the HU were visited more frequently and more on schedule. Ideally the number for “0-33 Days %” is as close 
as possible to 100%. 
 
Health Unit Sync Status 
This status bar shows how many HU’s have been synced into the data for the filters selected. The number under 
No is how many HU’s have not been fully synced into the currently viewed data. The number under Yes is how 
many have been fully synced and are contributing to the data being viewed. If only the Yes appears it means that 
100% of the HU’s for the selected filter have been synced. These numbers will readjust whenever you change 
the filters on the page. 

Tab 2: Cold Chain Status Report 
This tab gives information on the refrigerators at the HU’s. Use the dropdown menu to select the province and 
the sliding time scale to pick a time period. 
 
Pay special attention to: 
 
Non-Working Refrigerators 
This section is important because it specifies nonworking refrigerators at each HU. You can see the facility name, 
the brand/model of the refrigerator and the current problem. 
 
Functioning Refrigerators 
The graph at the left shows the percentage of working refrigerators at the HU’s. The ideal 95% working. The blue 
line shows actual data and the dashed black line is the trend line. If you click on the blue line you can see 
specific data values for the % Functioning Refrigerators for each month within the period you selected. 

Last Data Update Time  
This table indicates the last time that data was pulled from SELV and incorporated into the report.  
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Understanding Report Tabs (continued) 
There are three main tabs that are important to understand. These portray the same information that is on 
the PDF report but they allow for a more interactive understanding of the data. 

Tab 3: Relatório de Distribuição de Vacinas 
This tab gives information on HU’s visited and reported, Delivery intervals, Stockouts, and No Visit Reasons. Use 
the drop-down menu to select a province and sliding bar scale to select a time period. Clicking on the graphs on 
this page will take you to the detailed sheet for that specific data. To return to the graph click the Vaccines 
Distribution Report at the bottom of the workbook. 
 
Pay special attention to: 
 
Health Units Visited and Data Reported 
This graph shows the percentage of health units that reported and the  
percentage of those that were also visited. If only one line appears it  
means that the percentages are the same. 
 
 
 
 
 
 
 
 
 
 
 
 
Delivery Intervals 
This stacked bar chart that shows the delivery intervals for the province  
for the past 8 months. The ideal is having a large portion of 0-33 Days  
in each bar and a very small portion of the other amounts.  
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